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1. Notes 
This user manual is a guide to the research product BESA Connectivity – a stand-alone software 
program. 

The manual introduces the features, workflows, and the Main Windows and dialogs of the BESA 
Connectivity software. A help function is provided within the software. Press F1 on the keyboard or 
select menu item Help → BESA Connectivity Help for help. 

Before starting to work with BESA Connectivity, please read this user manual carefully. 

Please report any suggestions and errors found in this manual via email to feedback@besa.de. 

BESA GmbH provides support to all customers who have purchased BESA Connectivity directly from 
our sales office (sales@besa.de) or through our distributors. 

BESA GmbH 
Freihamer Str. 18 
82166 Gräfelfing - Germany 

In case of support requests, please visit our support portal at https://besa-support.de. 

  

mailto:feedback@besa.de
mailto:sales@besa.de
https://besa-support.de/
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2. Intended Use  and Intended User, Product Classification and 
Certification, Installation Instructions, and System Requirements 

Available in the BESA Connectivity 2.0 documents provided at https://www.besa.de/products/besa-
connectivity/downloads/. 

2.1. Before Setup 

BESA Connectivity is available as 64-bit program. Please make sure your Windows system 
supports it prior to the installation. The installation and initial setup of BESA Connectivity must be 
carried out by an administrator or experienced technical staff. 

2.2. Installation Instructions and Settings for BESA License Key 

Available in the BESA License Key documents provided at 
https://www.besa.de/home/downloads/besa-license-key/ 

2.3. Start the Program  

 

Start BESA Connectivity using the shortcut created on the desktop or run 
BESA Connectivty.exe from the BESA → BESA Connectivity 2.0 folder 
in the Start menu. 

First, the Welcome Screen appears. Press Accept to start BESA 
Connectivity. 

2.3.1. Specify the BESA Connectivity Data Folder 

As initial configuration step, the BESA Connectivity Data Folder must be specified. This is the folder 
where BESA Connectivity stores all project and result data to and reads from. 

When starting the program for the first time, the following dialog box appears:  

 

The BESA Connectivity Data Folder is pre-selected to Public Users on the local PC (shown above for 
Windows 10). 

Press the OK button if you want to use the pre-selected local folder in Public Users.  

Press the Edit button to create your BESA Connectivity Data Folder elsewhere, e.g. on a server. 

When the selection is accepted, the following confirmation dialog appears:  

https://www.besa.de/products/besa-connectivity/downloads/
https://www.besa.de/products/besa-connectivity/downloads/
https://www.besa.de/home/downloads/besa-license-key/
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Press the OK button.  

BESA Connectivity is now configured to start projects. 

Notes 

1. The procedure to define the shared BESA Connectivity Data folder on the server needs to be 
carried out only once at each PC where you install BESA Connectivity, i.e. when starting the 
program for the first time.  

2. When switching between BESA Connectivity Data folders, it is recommended to leave the tick 
mark on to update all existing projects in the new BESA Connectivity Data folder. 
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3. Introduction  

3.1. Features of BESA Connectivity  

BESA Connectivity provides optimized, user-guided workflows for time-frequency and connectivity 
analysis of EEG/MEG data. Multiple well-established methods are provided. The program is maximally 
user-friendly. All analyses are computed automatically with required user-interaction reduced to a 
minimum. The time-frequency and connectivity values computed in BESA Connectivity can be directly 
used for scientific reports. The outcomes can be exported also for further statistical analysis. All results 
are visualized and can be directly used for publications. 

BESA Connectivity integrates optimally with data that were analyzed in BESA Research, but it can 
also process data from other software packages as long as they conform to the BESA Connectivity file 
format. 

BESA Connectivity will automatically identify connectivity patterns between channels / regional 
sources or dipole sources, which can be visualized using 2D matrices or 3D visualization. 

There are two workflows with four work steps each in BESA Connectivity: 

I. Time-Frequency Analysis 
1. Set Project targets 

a)  Complex Demodulation 

b)  Wavelet Analysis (Morlet or Mexican Hat) 

c)  Multitaper 

d)  Number of Conditions and their names 

2. Load Data 

3. Set Parameters 

Various settings can be adjusted which will set the temporal – frequency resolution of 
further analysis. Here the user can also exclude individual trials from further analysis 
and set up low and high cutoff frequencies. 

4. Perform Calculations 

A time-frequency analysis will run. After completing of computation results can be 
evaluated and exported. When finishing this work step, the project can be saved and 
re-used for connectivity analysis. It is also possible to export analysis results in ASCII 
format. 

II. Connectivity Analysis 
1. Set Project targets 

a)  Coherence (Rosenberg et al., 1989) 

b)  Imaginary Part of Coherency (Nolte et al., 2004) 

c)  Phase Locking Value (Lachaux et al., 1999) 

d)  Phase Lag Index (Stam et al., 2007) 

e)  Weighted Phase Lag Index (Vinck et al., 2011) 

f) Directed Phase Lag Index (Stam and van Straaten, 2012) 

g)  Granger Causality (Granger, 1969; Geweke, 1982) 

h)  Partial Directed Coherence (Baccala and Sameshima, 2001) 

i) Directed Transfer Function (Kaminski and Blinowska, 1991) 

2. Load Data 
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3. Set Parameters 

Non-Parametric Method settings can be adjusted here (number of iterations, tolerance 
and regularization). Also, time-frequency analysis results from the previous workflow 
can be reviewed here. 

4. Perform Calculations 

A connectivity analysis will run. When analysis is completed the results can be 
reviewed for each method that was selected in the first work step. A 3D mode of 
visualization is also available. Analysis outcome can be saved and re-opened later. It 
is also possible to export them in ASCII format. 
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4. Time-Frequency methods 
The general approach to analyse event-related EEG/MEG oscillations is based on the decomposition 
of the EEG/MEG signals into magnitude and phase information for each frequency and to track their 
changes over time. This procedure is referred to as ‘time-frequency analysis‘ and comprises those 
methods that study a signal in both the time and frequency domains simultaneously. 

In BESA Connectivity, three approaches for computing time-frequency decomposition are provided: 

• Complex Demodulation is based on the convolution of the EEG/MEG signal with series of 
sine and cosine waves. 

• Wavelet Transform uses series of complex Morlet or Mexican Hat wavelets to extract the 
magnitude and phase information. 

• Multitaper Transform uses more than one taper to decompose the signal in its frequencies. It 
combines the properties of the different tapers to control the leakage and smooth the signal in 
the frequency domain. 

The methods are described in more detail in the following paragraphs. 

4.1. Complex Demodulation 

Complex Demodulation (Papp and Ktonas, 1977) is based on the convolution of the EEG/MEG signal 
with series of sine and cosine waves. For each frequency of interest 𝑓0 the following steps are 
performed: 

a) The original time-domain signal is multiplied by 𝑠𝑖𝑛(2𝜋𝑓0𝑡) and 𝑐𝑜𝑠(2𝜋𝑓0𝑡), respectively. This 
modulation operation shifts every signal at frequency f to the difference and sum frequencies 
(𝑓 ± 𝑓0) in the frequency domain. 

b) The resulting two signals are low-pass filtered to extract the frequency range that was 
originally centered around 𝑓0 and was shifted to the low frequency range 𝑓 − 𝑓0. Thus, the 
low-pass cutoff frequency sets half of the width of the frequency band for which the envelope 
amplitude and phase is computed. Thereby, this filter implicitly defines the resolution in time 
and frequency.  

c) The two output signals of step b) define the real and imaginary part of a complex signal as a 
function of time. Its magnitude corresponds to half the envelope amplitude and its phase to the 
compound phase of the filtered frequency band centered at 𝑓0. 

4.2. Wavelet Transform 

Like for Complex Demodulation, decomposition of the original EEG/MEG signal time series is based 
on the convolution with a scaled and translated version of a template function in the time domain. In 
BESA Connectivity, complex Morlet and Mexican Hat wavelets are provided as template functions. 
The complex Morlet Wavelet is described as: 

𝜓(𝑡) =  𝜋−
1

4 (𝑒𝑖𝜔0𝑡 − 𝑒−
1

2
𝜔0

2

) 𝑒−
1

2
𝑡2

, 

where 𝑖 denotes the imaginary unit and 𝜔0 is 2𝜋 times the frequency of the unshifted and 
uncompressed mother wavelet. 

The temporal and frequency resolution can be adjusted defining the length of the used wavelets in 
standard deviations of the implicit Gaussian kernel and the width of the wavelets in number of cycles. 
‘Shorter’ wavelets will provide a finer temporal resolution at the expense of a coarser frequency 
resolution and vice versa. 



  

11 

The Complex Mexican Hat wavelet is formulated as: 

Real part: 

𝜓𝑟𝑒𝑎𝑙(𝑡) = (1 − (𝜋𝑡𝑓0)2)𝑒−
1
2

(2𝜋𝑡𝑓0)2
= (1 − 𝜏2)𝑒−

1
2

𝜏2
 

Imaginary part: 

𝜓𝑖𝑚𝑎𝑔(t) = 𝐴 ∗ {2
𝜏

√2
+ √𝜋 [𝑒𝑟𝑓𝑖 (

𝜏

√2
) 𝑒−

1
2

𝜏2
(1 − 𝜏2)]}, 

where 𝜏 = 𝜋𝑡𝑓0with target frequency 𝑓0. 𝐴 denotes a scaling factor and is heuristically chosen to be 
𝐴 = 0.54 for equal scaling of the real and imaginary part. 

A review of using wavelets for EEG/MEG analysis is given by Samar et al. (1999). The complex 
Mexican Hat wavelet was proposed by Addison et al. (2002). 

4.3. Multitaper Transform 

Multitaper analysis uses several tapers to decompose the signal in its frequencies. Here, Slepian 
Sequences (Percival and Walden, 1993) are used to construct the tapers, which are then used in a 
time-frequency decomposition of the signal. Multitapering combines the properties of the different 
tapers to control the leakage and smooth the signal in the frequency domain. The multitaper 
transformation uses a sliding time window with a length that decreases with increasing frequency. 

Multitapers are sets of functions, designed to reduce leakage between frequencies, rendering them 
well-suited for nonstationary processes with high dynamic ranges and rapid variations. Because 
Multitapers imply that the signal is convolved with multiple orthogonal tapers which are then averaged, 
the variance of this oscillation detection method across repeated measurements is reduced. In theory, 
the amplitude measurements taken with multitapers will thus have smaller error bars than Wavelets. 

The data is multiplied with spectral windows before the frequency decomposition (in this application, 
Slepian windows). Those window functions are designed to prevent leakage of power to neighbouring 
frequencies, as often happens for Wavelets. Convolution is repeated with a number of K different 
(orthogonal) windows, each window gives an independent estimate of the signal because they are 
orthogonal, thereby making the power estimate more reliable for noisy data. The number of tapers 
depends on the smoothing parameter set by the user. 

 
Example of Slepian sequences 
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4.4. Frequency sampling 

In complex demodulation, frequency resolution is the same across the spectrum. Thus, the spacing 
between frequencies is uniform, given by a time-frequency sampling parameter that is adjusted by the 
user. 

A wavelet has a frequency-dependent resolution. 

For Morlet wavelets, 𝜎𝑓 describes the width of the wavelet in the frequency dimension. It is given by 

𝜎𝑓 =
𝑓

𝑜𝑠𝑐𝑖𝑙
 

The full width at half maximum of a Gaussian bell curve is approximately at 2.3548 × 𝜎. According to 
the Nyquist theorem, it would be sufficient to sample this step width 2–3 times in order to reconstruct 
the shape of the resulting data values. In practice, it is assumed that sampling will be uniform in the 
logarithmically transformed frequency axis, and the sampling rate is fixed to 0.8 × 𝜎𝑓0

, where f0 is the 
lowest frequency used. For a frequency range of 1–50 Hz sampled with oscil = 5, this results in 27 
frequencies: 

Frequency [fn-fn-1] ln(frequency) [ln(fn) - ln(fn-1)] 

1.00  0.00  

1.16 0.16 0.15 0.15 

1.35 0.19 0.30 0.15 

1.57 0.22 0.45 0.15 

1.83 0.26 0.60 0.15 

2.12 0.30 0.75 0.15 

2.47 0.34 0.90 0.15 

2.87 0.40 1.05 0.15 

3.33 0.47 1.20 0.15 

3.87 0.54 1.35 0.15 

4.50 0.63 1.50 0.15 

5.23 0.73 1.66 0.15 

6.08 0.85 1.81 0.15 

7.07 0.99 1.96 0.15 

8.22 1.15 2.11 0.15 

9.55 1.33 2.26 0.15 

11.11 1.55 2.41 0.15 

12.91 1.80 2.56 0.15 

15.00 2.10 2.71 0.15 

17.44 2.44 2.86 0.15 

20.27 2.83 3.01 0.15 

23.56 3.29 3.16 0.15 

27.39 3.83 3.31 0.15 

31.84 4.45 3.46 0.15 
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37.01 5.17 3.61 0.15 

43.02 6.01 3.76 0.15 

50.00 6.98 3.91 0.15 

For the Mexican Hat wavelet, 

𝜎𝑓 = √2 𝑓. 

Since this would lead to very few wavelets, the factor is adjusted to 

𝜎′𝑓 =
√2 𝑓

4
. 

With this setting, the frequencies of the same range adjust to 17 frequencies: 

Frequency [fn-fn-1] ln(frequency) [ln(fn) - ln(fn-1)] 

1.00  0.00  

1.28 0.28 0.24 0.24 

1.63 0.35 0.49 0.24 

2.08 0.45 0.73 0.24 

2.66 0.58 0.98 0.24 

3.40 0.74 1.22 0.24 

4.34 0.94 1.47 0.24 

5.54 1.20 1.71 0.24 

7.07 1.53 1.96 0.24 

9.03 1.96 2.20 0.24 

11.53 2.50 2.45 0.24 

14.72 3.19 2.69 0.24 

18.80 4.08 2.93 0.24 

24.01 5.21 3.18 0.24 

30.66 6.65 3.42 0.24 

39.15 8.49 3.67 0.24 

50.00 10.85 3.91 0.24 

This is close to the spacing which emerges for Morlet wavelets with an oscillation parameter of 3. 

For Multitaper transformations, the spectral resolution also depends on the current frequency. It was 
adapted such that for a smoothing constant of 1.0, the frequency spacing is the same as for Mexican 
Hat wavelets: 

𝜎′𝑓 =
√2 𝑓 𝑠

4
, 

where s is the smoothing constant. 

For the default smoothing constant of 0.4, the frequencies of the range shown above will adjust to 37 
frequencies: 
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Frequency [fn-fn-1] ln(frequency) [ln(fn) - ln(fn-1)] 

1.00  0.00  

1.11 0.11 0.11 0.11 

1.24 0.13 0.22 0.11 

1.39 0.14 0.33 0.11 

1.54 0.16 0.43 0.11 

1.72 0.18 0.54 0.11 

1.92 0.20 0.65 0.11 

2.14 0.22 0.76 0.11 

2.39 0.25 0.87 0.11 

2.66 0.27 0.98 0.11 

2.96 0.31 1.09 0.11 

3.30 0.34 1.20 0.11 

3.68 0.38 1.30 0.11 

4.11 0.42 1.41 0.11 

4.58 0.47 1.52 0.11 

5.10 0.53 1.63 0.11 

5.69 0.59 1.74 0.11 

6.34 0.65 1.85 0.11 

7.07 0.73 1.96 0.11 

7.88 0.81 2.06 0.11 

8.79 0.90 2.17 0.11 

9.80 1.01 2.28 0.11 

10.92 1.12 2.39 0.11 

12.17 1.25 2.50 0.11 

13.57 1.40 2.61 0.11 

15.13 1.56 2.72 0.11 

16.87 1.74 2.83 0.11 

18.80 1.94 2.93 0.11 

20.96 2.16 3.04 0.11 

23.37 2.41 3.15 0.11 

26.05 2.68 3.26 0.11 

29.04 2.99 3.37 0.11 

32.37 3.33 3.48 0.11 

36.09 3.72 3.59 0.11 

40.23 4.14 3.69 0.11 

44.85 4.62 3.80 0.11 

50.00 5.15 3.91 0.11 

 

4.5. Time sampling 

Time sampling is uniform for the complex demodulation and wavelets. Generally, the re-sampled data 
set (after time-frequency decomposition) has a time sampling rate that is either the same or lower than 
the original time sampling. 
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In complex demodulation, the time sampling is given by a time-frequency sampling parameter that is 
adjusted by the user. 

In wavelets, time sampling is automatically calculated such that no information is lost for the highest 
frequency wavelet. This will automatically ensure that also for lower frequencies, time sampling retains 
the time information contained in the data. 

For Morlet wavelets: 

𝜎𝑡 =
1

2𝜋 𝜎𝑓

=
𝑜𝑠𝑐𝑖𝑙

2𝜋𝑓
 

This value is computed for fmax, and again sampled at 0.8 × 𝜎𝑡 as in the frequency sampling case. If 
possible, the nearest sampling rate is found (within ±10% of that value) that is rounded to full 
milliseconds and keeps an integer number for the number of samples. 

For Mexican Hat wavelets,  

𝜎𝑡 =
1

2𝜋𝑓
. 

The same procedure is followed as for Morlet wavelets. 

For example, in a data set of 1600 ms: 

Method High cutoff 
frequency 

Number of 
oscillations 

Calculated 
sampling interval 

Adjusted 
sampling interval 

Morlet wavelet 60 Hz 5 10.610 ms 10 ms 

Mexican Hat 
wavelet 25 Hz n/a 5.092958 ms 4 ms 

 

For Multitaper, time sampling is automatically calculated such that no information is lost for the 
highest frequency taper. Sampling thus depends on fmax and the smoothing constant. 

The value 𝜎𝑡 = 1/𝑓 is computed for fmax, and again sampled at 0.8 × 𝜎𝑡 as in the frequency sampling 
case. If possible, the nearest sampling rate is found (within ±10% of that value) that is rounded to full 
milliseconds and keeps an integer number for the number of samples. 

4.6. Cone of influence 

When applying time-frequency decompositions to finite length time-series, the resulting transforms 
inevitably suffer from border distortions. This is due to the fact that the values of the transform at the 
start and the end of the time-series are always incorrectly computed, since they involve missing values 
of the series which are then artificially prescribed. To minimize these edge effects, it is recommended 
to pad the time-series of each epoch with additional data prior to the epoch start and after the epoch 
end. The region in which the result of a time-frequency decomposition suffers from these effects is 
called the cone of influence (COI). In this area the results are subject to border distortions and have to 
be interpreted carefully. 

The figure below shows a temporal-spectral evolution plot for power based on a Wavelet transform 
(Morlet wavelets). The cone of influence, which indicates the region affected by edge effects, is shown 
with a blue dashed line. 
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A step-by-step guide to wavelet analysis is given by Torrence and Compo (1998). This paper also 
introduces the cone of influence and its mathematical description. 

Notes 

• If you start BESA Connectivity from BESA Research, a default padding of 2 seconds before 
and after each trial epoch is added. This will in most cases solve the issues of the cone of 
influence. The tables below show padding values for Morlet wavelet parameters, Mexican hat 
wavelets, and complex demodulation parameters. 

Start frequency [Hz] Wavelet width Wavelet 
oscillations Padding required [s] 

0.5 

3 
3 2.9 

5 4.8 

5 
5 8.0 

7 11.1 

1 

3 
3 1.4 

5 2.4 

5 
5 4.0 

7 5.6 

2 

3 
3 0.7 

5 1.2 

5 
5 2.0 

7 2.8 

5 

3 
3 0.3 

5 0.5 

5 
5 0.8 

7 1.1 

Morlet wavelet parameters and required padding to avoid cone of influence for different start 
frequencies 

Start frequency [Hz] Padding required [s] 

0.5 2.7 
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1 1.6 

2 0.9 

5 0.41 

Mexican hat wavelet: required padding to avoid cone of influence for different start 
frequencies. There are no wavelet parameters to modify wavelet shape here. 

Start frequency [Hz] Time-frequency sampling 
[Hz, ms] Padding required [s] 

0.5 
0.2, 250 2 

0.25, 200 1.6 

1 

0.2, 250 2 

0.25, 200 1.6 

0.5, 100 0.8 

2 

0.2, 250 2 

0.25, 200 1.6 

0.5, 100 0.8 

1.0, 50 0.4 

5 

0.2, 250 2 

0.25, 200 1.6 

0.5, 100 0.8 

1.0, 50 0.4 

2.0, 25 0.2 

2.5, 20 0.16 

Complex demodulation parameter and required padding to avoid cone of influence for different 
start frequencies 

Start frequency [Hz] Padding required [s] 

1 2 

2 1 

5 0.4 

Multitaper: required padding to avoid cone of influence for different start frequencies 

• If you are using the TSE (temporal-spectral evolution) option, you should ensure that your 
baseline interval does not overlap with the cone of influence, since this may distort your TSE 
results over the whole time range in the affected frequency bands. 
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5. Connectivity methods 
BESA Connectivity offers nine connectivity measures in the frequency domain. Six measures are 
phase-based methods: coherence, imaginary part of coherency (or imaginary coherence), phase 
locking value (PLV), phase lag index (PLI), weighted phase lag index (WPLI), and directed phase lag 
index (dPLI). The other three measures are Granger causality-based connectivity approaches: 
Granger causality in the frequency domain (or Granger–Geweke causality), partial directed coherence 
(PDC), and directed transfer function (DTF). An overview of the distinctions between the connectivity 
measures is given in Table 1. 

Table 1. Comparison of the methods for estimating brain connectivity. 

5.1. Phase-based connectivity methods 

5.1.1. Coherence 

Coherence is a measure of the linear relationship between two signals at a specific frequency. In 
practice, the magnitude of the coherency is generally used for coherence. Coherency is defined as the 
normalized cross-spectrum: 

C𝑥𝑦(𝑓) =
〈𝑆𝑥𝑦(𝑓)〉

√〈𝑆𝑥𝑥(𝑓)〉〈𝑆𝑦𝑦(𝑓)〉
, 

where <·> indicates averaging over trials, 𝑆𝑥𝑦 is the cross-spectral density between two signals, and 
𝑆𝑥𝑥 and 𝑆𝑦𝑦 are the autospectral densities for signals 𝑥 and 𝑦, respectively. Coherence is defined as 
the magnitude of coherency 

Coh𝑥𝑦(𝑓) = |C𝑥𝑦(𝑓)| = |
〈𝑆𝑥𝑦(𝑓)〉

√〈𝑆𝑥𝑥(𝑓)〉〈𝑆𝑦𝑦(𝑓)〉
| . 

The estimated coherence for a given frequency ranges between 0 and 1. A value of 0 indicating that 
the two signals are perfectly uncorrelated, and a value of 1 indicates perfect correlation. Coherence is 
a bivariate measure, which means it considers only two signals simultaneously. It is also a 
nondirectional connectivity measure, that is, Coh𝑥𝑦(𝑓) = Coh𝑦𝑥(𝑓). 

 Coherence Imaginary 
coherence PLV PLI WPLI dPLI Granger 

causality PDC DTF 

Nondirectional ●  ● ● ●     

Directional  ●    ● ● ● ● 

Bivariate ● ● ● ● ● ● ●   

Multivariate        ● ● 

Linear ● ● ● ● ● ● ● ● ● 

Frequency 
domain ● ● ● ● ● ● ● ● ● 
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5.1.2. Imaginary Part of Coherency 

Instead of estimating the magnitude of the coherency, Nolte et al. (2004) proposed using only the 
imaginary part of the coherency to investigate brain interactions. This is because the imaginary part of 
the coherency excludes coherent sources with zero phase lag and therefore reduces the effect of field 
spread due to volume conduction. The imaginary part of coherency is defined as 

ICoh𝑥𝑦(𝑓) = 𝑖𝑚𝑎𝑔 (C𝑥𝑦(𝑓)) = 𝑖𝑚𝑎𝑔 (
〈𝑆𝑥𝑦(𝑓)〉

√〈𝑆𝑥𝑥(𝑓)〉〈𝑆𝑦𝑦(𝑓)〉
) , 

where 𝑖𝑚𝑎𝑔(∙) denotes the imaginary part. 

The imaginary part of coherency for a given frequency ranges between -1 and 1. If the value is 
positive, signals 𝑥 and 𝑦 are interacting and 𝑦 is earlier than 𝑥, indicating that information is flowing 
from 𝑦 to 𝑥. The imaginary part of coherence is a bivariate measure as the coherence, and it is 
antisymmetric, that is, ICoh𝑥𝑦(𝑓) = −ICoh𝑦𝑥(𝑓). 

5.1.3. Phase Locking Value 

Phase locking value (PLV) is a measure for phase synchronization. The PLV is defined based on the 
average of phase angle difference between two signals over time at a specific frequency (Lachaux et 
al., 1999): 

PLV𝑥𝑦(𝑓) = |
1

𝑛
∑ 𝑒

𝑖∙(𝜙𝑥,𝑡−𝜙𝑦,𝑡)

𝑛

𝑡=1

| , 

where 𝑛 is the number of time points, 𝑖 is the imaginary number that results from taking the square 
root of -1, and 𝜙

𝑥
 and 𝜙

𝑦
 are phase angles from signals 𝑥 and 𝑦 at frequency 𝑓. 

The PLV takes values between 0 and 1. A value close to 1 means perfect phase locking, while a value 
close to 0 results from a random phase distribution over time. PLV is a nondirectional connectivity 
measure, that is, PLV𝑥𝑦(𝑓) = PLV𝑦𝑥(𝑓). 

The coherence and PLV could provide similar results in many cases. However, coherence can be 
influenced by strong increase or decreases in power as it considered power information of the signals. 
For instance, if connectivity increases but the amplitudes of signals simultaneously decreases, 
estimated coherence values could be biased. PLV is insensitive to the amplitudes of signals and only 
depends on the phase relationship between two signals. 

5.1.4. Phase Lag Index 

Phase lag index (PLI) is used to measure the asymmetry of the distribution of phase differences 
between two signals by calculating the consistency of the sign of the imaginary component of the 
cross-spectrum (Stam et al., 2007). Similar to the imaginary part of coherence, the PLI is also less 
sensitive to the influence of volume conduction. The PLI is defined as 

PLI𝑥𝑦(𝑓) = |〈𝑠𝑖𝑔𝑛 (𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓)))〉| , 

where 𝑠𝑖𝑔𝑛(∙) is the signum function. 

The PLI ranges between 0 and 1. A value of 1 means perfect phase locking, while a value of 0 
indicates either no coupling or coupling with a phase difference centered around 0 mod 𝜋 (i.e. 
repeating at every 𝜋). The PLI will be closer to 1 the stronger this non-zero phase locking is. 

The imaginary part of coherence normalizes the imaginary component by the signal amplitudes (i.e., it 
is not based solely on the imaginary component of the cross spectrum), resulting in decreased 
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sensitivity for detecting changes in phase-synchronization, and increased sensitivity to noise. The PLI, 
on the other hand, is based solely on the imaginary component of the cross-spectrum. 

5.1.5. Weighted Phase Lag Index 

Weighted phase lag index (WPLI) is an extension of the PLI in which phase differences between two 
signals are weighted by the magnitude of the imaginary component of the cross-spectrum (Vinck et al., 
2011): 

WPLI𝑥𝑦(𝑓) =
|〈|𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓))| 𝑠𝑖𝑔𝑛 (𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓)))〉|

〈|𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓))|〉
=

|〈𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓))〉|

〈|𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓))|〉
. 

The application of the weighting decreases the probability of detecting false positive connections when 
dealing with volume-conducted noise sources with near zero phase lag while enhancing the sensitivity 
to detect phase synchronization. 

The WPLI takes values between 0 and 1 like the PLI. A WPLI value close to 1 means perfect phase 
locking, while a WPLI value close to 0 results from a random phase distribution over time. 

5.1.6. Directed Phase Lag Index 

The PLI is a measure of the strength of non-zero phase synchronization, but no longer indicates which 
of the two signals is leading in phase. On the other hand, the directed phase lag index (dPLI) can 
reflect which of the two signals is leading and which is lagging in phase. The dPLI is defined as the 
probability that the phase of one time series is smaller than the instantaneous phase of another signal 
(Stam and van Straaten, 2012): 

dPLI𝑥𝑦(𝑓) = 〈ℎ𝑒𝑎𝑣 (𝑖𝑚𝑎𝑔(𝑆𝑥𝑦(𝑓)))〉 , 

where ℎ𝑒𝑎𝑣(∙) is the Heaviside step function. 

The dPLI is bounded by 0 and 1. When time series x is consistently phase leading compared to y, 
0.5 < dPLI𝑥𝑦 ≤ 1. When time series x is phase lagging compared to y, 0 ≤ dPLI𝑥𝑦 < 0.5. In the case 
neither x or y is leading or lagging on average, dPLI𝑥𝑦 = 0.5. 

Note that the dPLI values are rescaled to range between -1 and 1 like the imaginary part of the 
coherency in BESA Connectivity: 

dPLÎ𝑥𝑦(𝑓) = 2(dPLI𝑥𝑦(𝑓) − 0.5). 

Therefore, when time series x is consistently phase leading compared to y, 0 < dPLÎ𝑥𝑦 ≤ 1. When time 
series x is phase lagging compared to y, −1 ≤ dPLÎ𝑥𝑦 < 0. In the case neither x or y is leading or 
lagging on average, dPLÎ𝑥𝑦 = 0. 

5.2. Granger causality-based connectivity measures 

Connectivity measures based on Granger causality in the frequency domain can be calculated with 
parametric approach (with autoregressive models) or with non-parametric approach (with Fourier or 
wavelet-based methods) (Dhamala et al., 2008a and 2008b). These approaches differ in how the 
transfer function matrix computed. The transfer function matrix 𝐇(𝑓) contains information about the 
relationships between signals and their spectral characteristics, and it allows for estimating causal 
relationships since it is nonsymmetric matrix. Once the transfer function is estimated, causality 
measures in frequency domain based on Granger causality can be accordingly computed. 

The non-parametric approach is based on the fact that the cross-spectral density matrix 𝐒(𝑓) can be 
factored into a noise covariance 𝚺 and spectral transfer function 𝐇(𝑓) by applying Wilsons’s spectral 
matrix factorization (Wilson, 1972). In comparison to the parametric estimation technique, the main 
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advantage using the non-parametric technique is that it does not require the determination of the 
model order for the autoregressive model. The choice of the appropriate model order can be 
problematic. In contrast, the non-parametric spectral factorization approach requires more data and a 
smooth shape of the cross-spectral density matrix (i.e., no sharp peaks as a function of frequency) to 
converge to a stable result. Moreover, the non-parametric approach utilizes data points from broad 
frequency range (ideally from 0 Hz to Nyquist frequency). 

In the BESA Connectivity, the non-parametric approach is implemented for connectivity measures 
based on Granger causality. 

5.2.1. Granger Causality 

Granger causality states that if past values of time series 𝑦(𝑡) contains information that helps in the 
prediction of time series 𝑥(𝑡), then 𝑦(𝑡) is said to cause 𝑥(𝑡) (Granger 1969). The bivariate Granger 
causality from signal 𝑦 to signal 𝑥 can be derived out of the univariate autoregressive model of 𝑥 and 
the bivariate model of 𝑥 and 𝑦: 

GC𝑦→𝑥 = ln (
Varx|x

Varx|xy 
) , 

where Varx|x is the variance of the residual in the univariate model, and Varx|xy is the variance of the 
residual in the bivariate model. If the past values of 𝑦 improve the prediction of 𝑥, then the variance 
Varx|xy is decrease. In this case, the variance ratio is larger than 1, which leads to a Granger causality 
value that is larger than 0. 

Geweke (1982) applied the concept of the Granger causality in the frequency domain. Therefore, the 
Granger causality in the frequency domain is also called as Granger-Geweke causality. In the BESA 
Connectivity, the Granger causality in the frequency domain is implemented. 

5.2.2. Partial Directed Coherence 

The partial directed coherence (PDC) is a multivariate directional connectivity measure that shows the 
direct interrelations between signals (Baccala and Sameshima, 2001). The magnitude of PDC is 
defined as: 

|PDC𝑖𝑗(𝑓)| =
|𝛬𝑖𝑗(𝑓)|

√∑ |𝛬𝑘𝑗(𝑓)|2𝑁
𝑘=1

, 

where 𝛬𝑖𝑗(𝑓) is an element of the 𝚲(𝑓) = 𝐇−1(𝑓) (the inverse matrix of the transfer function). The 
PDC𝑖𝑗(𝑓) describes the directional flow of information from the activity in 𝑗-th signal to the 𝑖-th signal 
(𝑗 → 𝑖). The PDC quantity is normalized between 0 and 1, producing a ratio between transmission from 
signal 𝑗 to signal 𝑖 and total outflow from signal 𝑗 (the sum along the columns of 𝚲(𝑓)). 

5.2.3. Directed Transfer Function 

The directed transfer function (DTF) is a multivariate directional connectivity measure that displays the 
direct and indirect interactions between signals (Kaminski and Blinowska, 1991). The magnitude of 
DTF is defined as: 

|DTF𝑖𝑗(𝑓)| =
|𝐻𝑖𝑗(𝑓)|

√∑ |𝐻𝑖𝑘(𝑓)|2𝑁
𝑘=1

, 

where 𝐻𝑖𝑗(𝑓) is an element of the transfer function matrix 𝐇(𝑓). The DTF𝑖𝑗(𝑓) expresses the directional 
flow of information from the activity in 𝑗-th signal to the 𝑖-th signal (𝑗 → 𝑖). The DTF quantity is 
normalized between 0 and 1, producing a ratio between the influence of signal 𝑗 on signal 𝑖 and the 
summarized inflow to signal 𝑖 (the sum along the rows of 𝐇(𝑓)). 
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6. The Workflow Concept  
BESA Connectivity uses a modern workflow concept that guides you through all the work steps 
needed to complete a project, suggests and explains necessary inputs and user actions, and performs 
many work steps automatically. At any time, you may interrupt and inspect earlier work steps or redo 
them with modified input parameters if required. 

 

A workflow consists of a series of work steps required to finalize a project. Each work step contains a 
set of user interactions needed to achieve the work step-specific result. Only few user interactions are 
needed.  

When pressing the Next button or Space, a work step is completed and the next work step is loaded. 
Thus, the workflow of a project sequentially proceeds from one work step to the next. 

The layout of the BESA Connectivity screen is optimized for this workflow concept. The workflow 
menu—as shown on the left in the Workflow Window—gives an overview over all the work steps to 
be completed in the selected project (see 7.1). The workflow menu can be used to switch between the 
work steps. For example, you may redo an earlier step with different or advanced parameters and 
continue with automatic processing of all subsequent steps as defined before. 

The current results during a work step are shown in the Main Window in the center of the screen (see 
7.2). The Information Window below (see 7.3) provides advice and help information for the current 
work step. 

During each work step a specific dialog is shown in the Interaction Window on the right to allow for 
optimized user interaction relevant for the current work step (see 7.4). After completing all interactions, 
press the Next button at the bottom or Space to proceed to the next work step. Press the Previous 
button to go back one work step. After completing the last work step of the workflow, press the Finish 
button at the bottom of the Interaction Window to save all data created during the project. This saving 
step enables reloading the full workflow of a project with all work steps at a later time. 

A project is defined by a specific workflow together with the stored individual input and output data. 
Stored projects can be viewed by selecting the menu item File → Open Project, by using the Open 
button in the toolbar, or by pressing the Open Project buttons on the start screen. After opening a 
stored completed project, the final workflow result is displayed. 
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7. Elements of the BESA Connectivity Screen 
The layout of BESA Connectivity screen is optimized for the workflow concept as described in chapter 
6. The figure below shows the BESA Connectivity screen with all its elements:

 

1 Workflow Window (see chapter 7.1) 

2 Main Window (see chapter 7.2) 

3 Information Window (see chapter 7.3) 

4 Interaction Window (see chapter 7.4) 

5 Title Bar (see chapter 8.1) 

6 Menu Bar (see chapter 8.2) 

7 Caption (see chapter 8.3) 

8 Toolbar (see chapter 8.4) 
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7.1. Workflow Window 

The Workflow Window on the left displays the workflow menu. The workflow menu gives an overview 
of the sequential steps needed to finish the current project. Steps already completed are marked with 
a green check mark.  

The current work step is highlighted. This step is also shown in the caption. 

The workflow menu can be used like any other menu to jump to another work step provided that the 
previous work steps have already been completed. 

7.2. Main Window 

The Main Window area displays the results of the current work step. 

7.3. Information Window 

The information window displays a comprehensive help text related to the current work step. The help 
texts provide additional information, e.g. which file has been loaded. They suggest and explain the 
next user interaction to be done in the current work step. 

Underlined text in blue provides a hyperlink. Click on such a link to open the BESA Connectivity help 
at the indicated topic. 

 

7.4. Interaction Window 

The Interaction Window provides the user interaction for the current work step.  

The upper interaction elements are used to set parameters needed in the work step by using 
standard elements like buttons, edit boxes, and sliders. The effect of changing parameters is seen in 
the Main Window left of the Interaction Window.  

In some work steps, additional interaction elements are shown at the bottom of the Interaction Window 
to enable changing visualization parameters. 

Current parameters are accepted by pressing Space, or by pressing the Next button at the bottom 
prompting the workflow to proceed to the next work step. 

The Previous button is used to jump back to the previous work step. 

Notes 

1. You can also undo or redo a work step using the menu items Edit → Undo and Edit → Redo or 
by pressing Ctrl-Z or Ctrl-Y.  

2. Moving on to the next work step is fastest by pressing Space or Enter. 
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8. Program Bars 

8.1. Title Bar 

The title bar of BESA Connectivity displays the program name and version number. In addition, it 
shows information on the current project: 

• Group name  

• Project name  

• Project type 

8.2. Menu Bar 

The Menu Bar provides the menus listed below. Click on a menu to select and choose from the menu 
items that pop up. 

8.2.1. File Menu 

The File menu contains the following items: 

File menu item Description 

Create New Project Start a new project. 

Open Project Load an existing project. A choice can be made between project 
types time-frequency and connectivity. 

Close Project Close currently active project. Show the Select Project Page. 

Save Save the currently active project. 

Save As… Specify a filename for currently active project and save it. 

Delete Projects… Select one or multiple projects that shall be. 

Select Data Folder Select the folder to be used as BESA Connectivity Data Folder (see 
2.3.1). 

Update Data Folder Info Update the information file in the BESA Connectivity Data Folder 
(see 2.3.1). 

Exit Terminate the BESA Connectivity program. 

8.2.2. Edit Menu 

The Edit menu contains the following items: 

Edit menu item Description 

Undo Undo the last step completed in the current work step. 

Redo Redo the last step that was undone in the current work step. 
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8.2.3. View Menu 

The View menu can be used to change display settings for BESA Connectivity. It contains the 
following entries: 

View menu item Description 

Show Workflow Window By selecting or deselecting this menu item the Workflow Menu is 
displayed or hidden (see 7.1). 

Show Information Window By selecting or deselecting this menu item the Information Window  
is displayed or hidden (see 7.3). 

Standard Font Size, 
Large Font Size, 
Extra Large Font Size 

Select one of these menu items to specify the size of the font to be 
used in BESA Connectivity. 

Settings 

The following themes can be selected from the Themes menu item: 

• BESA Standard: the main window has a sandy background. 

• BESA White: the main window has a white background. 

The colormap used in 2D time-frequency and connectivity displays 
can be adjusted using the following menu items – separately for the 
case of sequential data and diverging data: 

• Sequential Colormap: Standard, Blue to Red 

• Diverging Colormap: Standard, Rainbow, Viridis, White to 
Red 

8.2.4. Export Menu 

The Export menu can be used for exporting vector graphics (*.eps), scalable vector graphics (*.svg) 
or bitmap images (*.png) of the Main Window, of the detail windows, or of a combination of all 
windows. For 3D visualization in the Connectivity workflow (see 11.4.1), the connectivity changes over 
time can be exported as video (*.mpg). 

Results can be exported in ASCII format for further processing in external programs if needed. For 
time-frequency analysis it is possible to export single trial data, averaged data, and averaged 
waveforms. Connectivity data can be also exported. 

Export menu item Description 

Image 

Allows exporting images of the Main Window, the left detail 
window, the right details window, or all windows (see 12.1). In the 
Save dialog, the format (*.eps, *.png, or *.svg) can be specified. 
Images can also be exported by right-clicking in the according 
window. 

Video 

For 3D visualization in the Connectivity workflow this item allows 
exporting video animations of the Main Window, the left detail 
window, the right details window, or all windows (see 12.2). In the 
Save dialog, the resolution, start time, end time, and duration per 
latency step can be specified. The rotation can be applied in 
degrees. Rotation can be uni-directional or bidirectional. Also, the 
background color can be changed. After pressing the recording 
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Export menu item Description 

button, video generation starts. When it is finished it can be 
previewed and saved as *.mpg file. 

Export Results 

Functionality of this menu entry is workflow-dependent. 

For the Time-frequency workflow it is possible to export ASCII data 
for single trials TF (*.tfcs), averaged TF (*.tfc), and averaged 
waveforms (*.avr) (see 12.3). 

In the Connectivity workflow, connectivity data can be exported as 
well (*.conn). All these files are ASCII files with appropriate header 
line (see 12.4). 

8.2.5. Help Menu 

Use the Help menu to open the program help or to get information about BESA Connectivity. 

Help menu item Description 

BESA Connectivity Help Open the program help. 

About… Get information about the current program version. 

8.3. Caption 

The caption is located between the Menu Bar and the Toolbar and specifies the current work step. 

8.4. Toolbar 

The Toolbar provides direct access to the most important menu items: 

File → Create New Project 

File → Open Project 

File → Close Project 

File → Save Project 

Edit → Undo 

Edit → Redo 
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9. How to use BESA Connectivity 
Before working with BESA Connectivity, please consult chapter 7 on the elements of the BESA 
Connectivity screen. 

9.1. Starting BESA Connectivity 

9.1.1. Welcome Screen 

Start BESA Connectivity from its icon on the desktop. 

When starting BESA Connectivity, a welcome screen appears. It provides some information on the 
BESA Connectivity program including the current version number and date: 

  

Press Accept to start BESA Connectivity. 
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9.2. The Workflows of BESA Connectivity 

Two different workflows can be chosen: Time-Frequency Analysis and Connectivity Analysis. Each 
workflow consists of specifying the analysis method, loading EEG/MEG data (for the Connectivity 
workflow a Time-Frequency analysis project outcome has to be used), specifying parameters, and 
calculation. The work steps are described in detail in the following chapters. 

 

9.3. Select workflow – Analysis type 

In order to start a workflow, a selection of the analysis type must be made: 

• Time-Frequency Analysis 

• Connectivity Analysis  

• Open Project 

Press Start to initialize the selected workflow. For a more detailed description of the analysis methods, 
please see the previous chapters 4 and 5. 
 

Note: Projects can also be started or opened at any time by selecting the menu items File → Create 
New Project or File → Open Project. 

9.4. Important Dialogs 

This section describes important user interactions realized by dialogs. 
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9.4.1. Select the BESA Connectivity Data Folder 

If required, you may switch to different or create a new BESA Connectivity Data Folder by selecting 
the menu item File → Select Data Folder. In the dialog box below, select an existing folder to store all 
result data of BESA Connectivity or create a new folder accessible to all users in your workgroup. 

Select a folder in this dialog and press Select Folder to set this folder as the current BESA 
Connectivity Data Folder. After selecting a new BESA Connectivity Data Folder, the following 
confirmation dialog appears: 

 

Press OK to activate the new BESA Connectivity data folder. 

It is recommended to leave the tick mark on to update all existing projects in the new BESA 
Connectivity Data folder, if you switch between folders. 

Note: When switching between different BESA Connectivity Data folders, the project data are 
preserved in each folder and are not copied to the new folder. 

9.4.2. Open Projects 

The Open Project dialog box shows the available projects. Project type can be selected using the 
Project Type option in the dialog box. The left pane shows Group, and the right pane shows all 
projects available for that Group, with their modification date. 

 

The previously used project is automatically selected. 

Icons in the list of projects: 

• Green tick mark: The project has been finalized. 
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• Green circle: All steps have been computed, but the project has not yet been finalized. 

• Yellow circle: All manual steps have been completed, but the project is still in progress.  

• Red circle: Some manual steps have not yet been completed. 

Icons in the list of groups: 

• Green tick mark: All projects of this group have been finalized.  

• Green circle: All steps have been completed for all projects of this group, but at least one 
project has not yet been finalized. 

• Yellow circle: All manual steps have been completed, but at least one project is still in 
progress. 

• Red circle: For at least one project, some manual steps have not yet been completed. 

After opening a finalized project, the project is unlocked and run through the worksteps automatically. 

9.4.3. Finish, Save, and Close Projects 

Finish a project 

The Save Project As… dialog box comes up proposing a group name if the project is new (see figure 
below). If a previous project has been opened and modified, the previous name is proposed. 

The selected group and proposed project names are highlighted automatically. To save under a 
different project name, the user enters a new project name in the Selected Project edit field. 

Pressing the Save button stores the project data. If the selected project name does not yet exist, the 
project is saved with all result files automatically. 

 

If the user keeps the highlighted project name of a previous project or selects another previous project 
name of the current Group in the Projects selection box on the right, he/she will be asked whether to 
replace the previous project by the new project data: 
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• Yes discards the previous project data and stores the new data under the previous project 
name. 

• No saves under a different project name. The Save Project As… dialog box comes up again. 

Close a project 

At any time during the workflow, you may close the current project using the Close Project button in 
the toolbar or the menu item File → Close Project. 

When closing a project, the following dialog box comes up: 

 

• Press Yes to save the changed project data. Previously stored data will be overwritten. 

• Press No if you want to discard all changes, e.g. when accidentally modifying user defined 
parameters during reinspection after opening an existing project. In this case, the stored data 
of the current, previously saved project will not be overwritten and changes to the project will 
not be stored.  

• Press Cancel to return to the project workflow, e.g. if you want to save the current changes 
under a new project name using the menu item File → Save As. 

Save a project 

At any time during the workflow, data can be saved by selecting the menu item File → Save or typing 
Ctrl+S. However, previously stored data will be overwritten automatically. 

Notes on closing and saving: 

• Closing and saving can be done at any time during the preparation of a project to preserve the 
user input up to the completed workstep. 

• If a previously completed project has been opened, previous project data will be overwritten 
and replaced by the current state of the project. Therefore, do not use the save function when 
opening a previous project simply for inspection. In this case, use the menu item File → Save 
As. 

• Select the menu item File → Save As to store a modified project under a new project name. 

• The current project name can always be seen in title bar. 

9.4.4. Delete Projects 

Stored BESA Connectivity projects can be deleted if no longer needed. To delete a project, select the 
menu item File → Delete Projects…. The Delete Projects… dialog box appears: 
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In the Project Type drop down selection box at the bottom, select the type(s) of projects to be deleted. 
Select All Projects to delete Time-Frequency and Connectivity projects. 

In the Group selection box, mark a group for which project data shall be deleted. Then, select the 
projects to be deleted in the Projects selection box (multiple Groups or Projects can be selected by 
holding the Ctrl or Shift key while selecting). 

A confirmation box is displayed, after selecting and pressing Delete. 

• Press Yes if you do not need the listed project data any more. Restoring is no longer possible 
after deleting. 

• Press No to prevent deleting. 

9.4.5. Select Files 

When selecting input data, the following dialog appears: 

 

Use the drop-down folder list at the top to navigate to the desired input folder. Then, select files in the 
current folder and press Open. 
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10. Workflow: Time-Frequency Analysis 

10.1. Set Project targets 

The time-frequency analysis method needs to be specified from multiple selection options: 

• Complex Demodulation: Data will be transformed to time-frequency domain using complex 
demodulation (see chapter 4.1 for more details). 

• Wavelet Transform: Data will be transformed to time-frequency domain using one of two 
possible wavelet approaches (see chapter 4.2 for more details). 

o Wavelet Morlet 

o Wavelet Mexican Hat 

• Multitaper: Data will be transformed to time-frequency domain using Multitaper transform (see 
chapter 4.3 for more details). 

• Number of Conditions: Up to ten conditions (e.g. target and control) can be provided. 

• Define Condition Names: Condition names can be set for all of the selected Number of 
Conditions. 

The number of conditions and condition names will be automatically detected if the workflow is started 
from the BESA Research software. 

After selecting the analysis method data has to be loaded and some further settings need to be 
specified. Press Next to go to the next work step. 

10.2. Load data 

In this work step data for the analysis have to be provided. The number of datasets to load depends 
on the number of conditions declared in the previous step. BESA Connectivity reads the *.generic file 
format which is the output from BESA Research. The generic files can be easily generated from any 
other software following the format description. Please see chapter 14.3 for further details.  

Pressing the first Load Data for <Condition 
1> button will bring up a file selector box 
(Condition 1 text will be replaced with the 
actual name of the first condition).  

If several conditions were indicated in the 
Set Project Targets work step, multiple 
buttons Load Data for <Condition> will be 
available. Pressing this button will also bring 
up a file selector box. 

Note: When selecting multiple data files for 
each condition, make sure that the condition 
names of the selected data files are the 
same. 

 

After file opening, the details of each loaded file will be displayed. The following screenshot shows an 
example data set containing 3 conditions 60dB, 70dB and 80dB with several files loaded for each 
condition. 
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Press Next to go to the next work step or Previous to switch back to the Set Project Targets work 
step. 

10.3. Set Parameters 

The window layout for the Set Parameters work step in the Time-Frequency workflow is presented 
below. 

 

The Main Window shows single 
trial waveforms, as selected in 
the interaction window, for the 
indicated condition and every 
channel / source. 

The left Detail Window displays 
an averaged waveform from all 
selected trials, for the selected 
channel. 

The right Detail Window 
displays the selected single 
trial waveform for the indicated 
condition and channel / source. 
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The Time-Frequency Settings consist of three 
parameters. 

The Select Trials or Select Files window allows to 
review the single trials before performing time-frequency 
computation. Individual trials can be excluded if needed. 
To exclude trial from further analysis a green checkbox 
adjacent to the trial number has to be unchecked. 

In case Grand Average has been selected in the Select 
Data Set element, all files for the current condition will be 
displayed. 

After selecting any of the trials, you can browse through 
the individual trials quickly by using the cursor up and 
cursor down keys on the keyboard. 

The Low Frequency Cutoff can be adjusted. By default, 
the low frequency cutoff is set to the minimum value 
possible for the provided data and method. The lowest 
frequency possible depends on the method settings of 
Complex Demodulation and/or Wavelet. 

The High Frequency Cutoff is detected from the data 
sampling and set to the highest possible value (that is 
below the Nyquist frequency). This value can be adjusted 
by selecting the value from the dropdown list. 

 

 

The Wavelet Settings depend on the wavelet type 
selected in the Set Project Targets workstep. The 
wavelet type is indicated in the widget. For Morlet 
wavelets, the following settings can be adjusted: 

Wavelet Width determines the width of the envelope 
function (Gaussian kernel) used for creation of the 
wavelet. Shorter wavelets will provide a finer temporal 
resolution at the expense of a coarser frequency 
resolution and vice versa. 

Number of Oscillations determines the number of 
oscillations present in the wavelet. Wavelets with lower 
number of oscillations will provide a finer temporal 
resolution at the expense of a coarser frequency 
resolution and vice versa. 

Larger wavelet widths or larger number of oscillations 
require longer wavelets, which in turn requires more 
padding at each side of the data for calculation. If not 
enough padding is available, zero padding is added. 
Please note that this can influence the data (cf. chapter 
4.6 for more information). 

In the Complex Demodulation Settings, the resolution 
of the time-frequency transform can be adjusted using the 
Time-Frequency Sampling combo box. If a high 
resolution in the frequency domain is selected (e.g. 0.5 
Hz sampling rate), this goes along with a low resolution in 
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the time domain (in this case: 100 ms sampling rate). 
Accordingly, a high time resolution (e.g. 10 ms sampling 
rate) is accompanied by a low frequency resolution (5 Hz 
sampling rate). The default value of this setting is “1 Hz, 
50 ms”. 

In the Multitaper Settings, the Frequency Smoothing 
parameter can be adjusted between 0.2 and 1.8 in steps 
of 0.1, and the default value of this parameter is 0.4. 
Specifying larger frequency smoothing values will result 
in more frequency smoothing. 

 

Select Data Set is shown if several files have been 
loaded for the current condition. The combo-box allows 
the selection of the conditions Grand Average or single 
files. 

Display Left enables or disables the presentation of 
average signal from all trials used for further analysis 
(defined in Select Trials/Files widget) in the left Detail 
Window. If Grand Average has been selected, the 
average signal from all included files will be displayed. 

Display Top/Left/Right allows to switch previously 
defined conditions in the Main Window, the left and the 
right Detail Window. In main and right windows, the 
currently selected waveform of a single trial is presented, 
whereas in the left detail window an average waveform of 
the selected channel for the selected condition is shown. 

Select Channel / Source: Depending on the loaded data 
file montage (source montage or channel montage) an 
appropriate text is displayed. This dropdown selection 
box allows the selection of a desired channel / source to 
be displayed in the Detail Windows. Alternatively, the 
channel / source of choice can be selected in the Main 
Window by a left-click. The arrow buttons left and right of 
the channel selector box can be used to quickly browse 
through all channels / sources. 

Current Latency allows setting a cursor at a particular 
latency (the slider can be dragged to the point of interest 
or the arrow buttons at the left and right of the slider bar 
can be used to adjust the position). 

 

  

Scale allows altering the scaling of the data. The arrow 
buttons at the left and right of the slider bar can be used 
to scale the data up or down. 

Zoom allows viewing the Main Window contents in 
greater detail. The arrow buttons at the left and right of 
the slider bar can be used to adjust the zoom factor. For 
zooming the mouse wheel can be used as well. The black 
frame at the left of the Zoom slider displays the position 
of the currently displayed window fraction relative to the 
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complete window. The frame can be left-dragged to 
another relative position. Alternatively, it is possible to 
left-drag the Main Window while holding down the control 
key. 

10.4. Perform Calculations 

Pressing Run Time-Frequency Analysis opens a window 
with a summary of the Time-Frequency Analysis Settings. 

• If Wavelet computation was selected, the name of 
the selected wavelet is indicated and, if applicable, 
its width and number of oscillations. 

• If Complex Demodulation was selected, the time-
frequency sampling values are shown. 

• If Multitaper was selected, the frequency smoothing 
value is displayed. 

If these values need changing, it is possible to return to the 
Set Parameters work step by pressing Cancel and the 
Previous button. Confirming the summary window with OK 
will start the time-frequency analysis. 

 

Please note that depending on the number of channels/sources and data points, the 
computation might take several minutes. 

After performing the computation, the results are displayed: 
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The Main Window shows 
the time-frequency plot for 
each channel / source for 
the selected time-
frequency analysis 
method, display type, and 
condition. 

The left Detail Window 
displays an averaged 
waveform from all selected 
trials, for the selected 
channel. 

The right Detail Window displays a 
time-frequency plot for the chosen 
channel / source with the selected 
time-frequency analysis method, 
display type, and condition. 

If more than one files was loaded for the 
currently selected condition, it is possible to 
switch between them or the Grand Average by 
selecting one of the files from the Select Data 
Set dropdown list.  

If more than one Time-Frequency analysis 
method was used, it is possible to switch 
between them by selecting one of the methods 
from the Select Time-Frequency Method 
dropdown list.  

In the Select Display Type selection group, the 
display can be switched between temporal-
spectral evolution (TSE) or Absolute (ABS) 
value, for Amplitude or Power. 

When the TSE check box is selected, time-
frequency plots are shown where the 
power/amplitude for each time is normalized to 
the mean power/amplitude of the baseline 
epoch for that frequency. Whether amplitude or 
power is used for the calculation depends on 
the state of the Amplitude/Power check box. 
The x-axis shows the time relative to the event, 
and the y-axis shows the frequencies. The 
intensities are displayed as a color-coded plot. 
The resulting TSE value (%) is computed as  

 

with 

A(t,f) = activity at time t and frequency f (either 
power or absolute amplitude) 

Abaseline(f) = mean activity at frequency f over 
the baseline epoch 

The TSE value is in the range from [–100%, 
+inf] and describes the spectral change of 
activity at sampling time t relative to the activity 
during the baseline epoch. A value of +100% 
means that activity is twice as high as during 
the baseline epoch. 

The averaged waveform display of the Detail 
Window can be switched on or off in the 
Display Left checkbox. By changing the 
selection in Display Top/Left/Right the 
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condition for which data are displayed can be 
changed (if more than one condition was 
selected in the beginning of the work flow). 

Select Channel / Source: Depending on the 
loaded data file montage (source montage or 
channel montage) an appropriate text is 
displayed. This dropdown list allows the 
selection of a desired channel / source to be 
displayed in the Detail Windows. Alternatively, 
the channel / source of choice can be selected 
in the Main Window by a left-click. The arrow 
buttons left and right of the channel selector 
box can be used to quickly browse through all 
channels / sources. 

The crosshair position over the time-frequency 
plot can be selected either by left mouse click 
on the desired position in the right Detail 
Window, by a double click in the Top View 
display, or by adjusting the Current Latency 
[ms] and Current Frequency [Hz] settings 
sliders. 

The remaining settings in the Interaction 
Window are analogous to the Set Parameters 
(see 10.3). 

Pressing Finish saves the current project 

Note that the color map for showing the data can be changed in the View menu: For TSE display, 
the currently selected diverging color map is used; for ABS display, the currently selected 
sequential color map is used. 

When hovering over the left or right detail window, the value of waveform amplitude or time-
frequency decomposed data for the given time-frequency sample is displayed in a tooltip text. 

 

Using the Blue-to-Red diverging color map in TSE display 
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After specifying a group and project name, 
projects including all completed workflows 
steps will be saved and marked with a green 
check mark. Completed, but not finished 
projects are marked by a green dot. 
Incomplete projects are marked by a red dot.  

A project can be re-opened at any time by 
pressing File / Open Project. 

 

11. Workflow: Connectivity Analysis 

11.1. Set Project targets 

There are multiple selection options for specifying the connectivity analysis method: 

• Coherence: describes the amount of in-phase components of two signals at a specific 
frequency (Rosenberg et al., 1989). 

• Imaginary Part of Coherency: excludes coherent sources with zero phase lag and therefore 
reduces the effect of field spread due to volume conduction (Nolte et al., 2004). 

• Phase Locking Value: is the average of phase angle difference between both signals over 
time at a specific frequency (Lachaux et al., 1999). 

• Phase Lag Index: measures the asymmetry of the distribution of phase differences between 
two signals and is less sensitive to volume conduction effects and reference electrode issues 
(Stam et al., 2007). 

• Weighted Phase Lag Index: is an extension of the PLI in which phase differences between 
two signals are weighted by the magnitude of the imaginary component of the cross-spectrum 
(Vinck et al., 2011). 

• Directed Phase Lag Index: is an extension of the PLI in which the direction of information 
flow can be determined (Stam and van Straaten, 2012). 

• Granger Causality: states that if past values of time series 𝑦(𝑡) contains information that 
helps in the prediction of time series 𝑥(𝑡), then 𝑦(𝑡) is said to cause 𝑥(𝑡) (Granger, 1969; 
Geweke, 1982). 

• Partial Directed Coherence: measure that only shows the direct interrelations between the 
signals (Baccala and Sameshima, 2001). 

• Directed Transfer Function: was introduced to reveal indirect information transfer between 
signals (Kaminski and Blinowska, 1991). 

For more details about each connectivity analysis method please refer to chapter 5 or to the original 
research papers mentioned for each method. 
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11.2. Load data 

Since connectivity computation is based on time-frequency data, this workflow requires data from a 
time-frequency analysis project.  

Pressing the Select Time-Frequency Input 
Project button will bring up a project selector 
box with project type filter fixed to Time-
Frequency Projects. Choose the desired 
project from any group and press Open to 
proceed.  

If an unfinalized project is selected (indicated 
by a red dot) a prompt dialog will be shown. 
Press Yes if workflow type should be 
switched back to time-frequency analysis in 
order to finalize the project. Press No or 
Cancel to select another project. 

After loading the project, the related details 
will be displayed in the Main Window, 
similarly to the Load data work step of the 
Time-Frequency analysis workflow (10.2) 

Press Next to go to the next work step or 
Previous to switch back to the Set Project 
targets work step. 
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11.3. Set Parameters 

The window layout for the Set Parameters work step in the Connectivity workflow reflects the 
calculations performed in time-frequency analysis and is presented below. 

 

The Main Window shows 
the time-frequency plot for 
each channel / source for 
the selected time-
frequency analysis 
method, display type, and 
condition. 

The left Detail Window 
displays an averaged 
waveform from all selected 
trials, for the selected 
channel. 

The right Detail Window displays a 
time-frequency plot for the selected 
channel / source with the selected time-
frequency analysis method, display 
type, and condition. 

If any of the non-parametric connectivity methods were 
selected in the Set Project Targets work step (Granger 
Causality, Partial Directed Coherence, or Directed Transfer 
Function), the additional Non-Parametric Methods 
Settings widget is available.  

The Number of Iterations, Tolerance, and Regularization 
can be adjusted either by editing the values manually or by 
clicking the left arrow to decrease / right arrow to increase. 

These parameters are required during the factorization of 
the cross-spectral density matrix. In each iteration, the 
estimation error of the spectral factors is recomputed. If the 
estimation error is lower than the tolerance threshold, the 
computation of this iteration is finished. The regularization 
(%) is applied in order to ensure a smooth shape of the 
cross-spectral density matrix. The regularization of 0.01 
indicates that a regularization parameter is set to 1% of 
mean of power spectral density values. 

The remaining settings in the Interaction Window are 
analogous to the Perform Calculation work step of the Time-
Frequency Analysis workflow (chapter 10.4). 
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11.4. Perform Calculations 

Pressing Run Connectivity Analysis opens a window with 
a summary of the Connectivity Analysis Settings. All 
selected methods are listed. 

• If non-parametric methods are planned to be 
computed (Granger Causality, Partial Directed 
Coherence, or Directed Transfer Function) the 
related settings are also displayed. 

If any of the values need to be changed, it is possible to 
return to the Set Parameters work step by pressing Cancel 
and the Previous button. Confirming the summary window 
with OK will start the connectivity analysis. 

 

Please note that depending on the selected connectivity method, the number of iterations in 
non-parametric settings, number of channels/sources and data points, the computation might 
take several minutes. 

After finalizing the computation, the results are displayed: 

 

In the Main Window, results 
are displayed either in a grid 
view to show all connectivity 
patterns in one view, or in a 
3D view (11.4.1), which 
shows either connectivity 
with connection strength 
encoded by thickness of 
connecting arrows, or the 
sum of inflow/outflow. 

The left Detail Window 
displays backward 
connectivity between 
channels / sources 
indicated by row and 
column in Top Window 
(Left and Right Source in 
selection widget). 

The right Detail Window displays 
forward connectivity between 
channels / sources indicated by row 
and column in Top Window (Left and 
Right Source in selection widget). 

Note that the color map for showing the data can be changed in the View menu: for display of 
Imaginary part of Coherency and Weighted Phase Lag Index, the currently selected diverging 
color map is used; for display of the other connectivity methods, the currently selected 
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sequential color map is used. When hovering over the left or right detail window, the value of 
connectivity for the given time-frequency sample is displayed in a tooltip text. 

If more than one files was loaded for the 
currently selected condition, it is possible to 
switch between them or the Grand Average by 
selecting one of the files from the Select Data 
Set dropdown list.  

Select Connectivity Method dropdown menu 
and Select Time-Frequency Method can be 
used to change the displayed results in the Main 
Window. 

View modes can be switched by checking the 
TFC View, 3D View or Circular Graph View 
checkboxes. These modes are described in 
more detail in chapter 11.4.1. 

If the analysis was performed for more than one 
condition, the displayed condition can be 
changed by selection in the Display 
Top/Left/Right section.  

The displayed connectivity between selected 
channels in left and right Detail Windows can be 
changed either by clicking on one of the plots 
available in the matrix in the Main Window, or by 
indicating the desired channels/sources in the 
Select Left Target Channel\Source and Select 
Right Target Channel\Source dropdown 
menus. These menus can also be scrolled by 
the arrows adjacent to both menus.  

The crosshair horizontal position can be 
adjusted by changing the position of the Current 
Latency [ms] slider. The crosshair vertical 
position can be altered by changing the position 
of the Current Frequency [Hz] slider. If the 
crosshair position is manually changed by 
clicking the left mouse button on the desired 
position in either the Left or Right Detail 
Window, the values of the Current Latency slider 
and Current Frequency slider will be 
automatically updated. Finally, the crosshair 
position is also updated by a double click into 
the selected channel in the top part of the Main 
Window display. 

If the Average over Time checkbox is enabled 
additional controls are shown and plots are 
averaged over time. The Start Time [ms] slider 
and End Time [ms] sliders indicate the time 
window that will be averaged over. The display 
changes: the X axis shows frequency and the Y 
axis shows connectivity values for the selected 
method (e.g. Coherence). 

The averaging can be performed also in the 
frequency domain by enabling Average over 
Frequency. Now, the averaging window can be 
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adjusted by the displayed Start Frequency [Hz] 
slider and End Frequency [Hz] slider. Plots 
show time values on the X axis; the Y axis 
shows connectivity values for the selected 
method (e.g. Coherence).  

The remaining settings in the Interaction 
Window are analogous to the Set Parameters 
work step (10.3)  

 

11.4.1. View Modes 

For display of Connectivity results, several viewing options are available: 

• TFC View  

• 3D View 

• Circular Graph View 

TFC View 

The TFC View will display the connectivity matrix between all pairs of sources or sensors for the 
currently selected method. If averaging over time and/or frequency is applied, connectivity values are 
shown for the selected time and/or frequency intervals. 

 

The matrix diagonal (Normalized Power Spectral Density – Normalized PSD) can be hidden by 
checking the Hide Diagonal checkbox. 

The TFC View provides the so-called Freeze Pane functionality, that allows you to keep the header 
row and header column visible on the screen, even as you scroll through a large data sets with a large 
number of sources or sensors.  
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3D View 

If the 3D View checkbox is enabled in the Interaction 
Window, the Main Window will display an averaged 
transparent brain surface (in case that brain sources 
are analyzed) or a non-transparent scalp surface (for 
sensor data analysis). The brain surface was kindly 
supplied by John E. Richards, University of South 
Carolina, USA (Richards et al., 2016). 

This view shows the brain connectivity for the 
selected time and frequency, also if averaging over 
time and/or frequency is applied. The controls 
available in the Interaction window are adjusted for 
the purpose of 3D view settings. 

Hover with the mouse pointer over any of the channels to view the channel label in a tool tip. The 
current connectivity values of the detail window channels are displayed at the bottom left part of the 
central window. 

If Show Connectivity Info checkbox is checked, further information for the currently selected pair of 
sources/sensors is shown in the main window. 

The Threshold slider is available only for Connectivity Strength visualization. Adjust this value either 
by manual editing, by moving the slider, or by pressing the left or right arrow to reject (hide) 
connectivity arrows with values below the selected value. 

Auto Thresholding: The Auto checkbox computes a threshold based on statistics. 

• For each frequency, the connectivity value distribution over the baseline interval is computed. For 
non-symmetric connectivity methods (e.g. Coherence), the threshold is set to the value corresponding 
to the 95th centile of the distribution. For symmetric methods (e.g. Imaginary Part of Coherency), the 
threshold is set to the value corresponding to the 97.5th centile. In case of averaging over a frequency 
range, the 95th (97.5th) centile values are also averaged over that range to provide the auto-
thresholding value. 

• If no baseline interval is provided, then the full interval will be used to compute the statistical 
threshold. Note that the baseline interval is read from the raw data, and is listed in the Load Data work 
step. 
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In 3D view mode the Zoom and the Scale 
settings in Display Settings are not available. 
These settings are replaced by the 3D view 
specific ones. One of three Display modes can 
be selected: Connectivity Strength, Sum Inflow 
and Sum Outflow. 

If Connectivity Strength is checked, cones will 
be displayed that indicate direction of 
information flow between two channels/sources: 
The thicker the base of the cone, the stronger 
the connection from the source to the 
destination. The reverse direction is also shown 
in the same way, except for Imaginary Part of 
Coherency and Directed Phase Lag Index 
where only the positive values are used. 

If Sum Inflow is selected, all input information 
flow for each node (channel/source) is 
summarized and expressed by the node size. 
Similarly, if Sum Outflow is selected, all output 
information flow for each node is summarized 
and expressed by the node size. 

 

 

 

The Scale 3D slider allows changing the size of all connectivity arrows or inflow/outflow nodes. 

To change brain visibility, adjust the Transparency slider value. The higher the value, the more 
transparent the brain will look. 

In scalp visualization, the Sum Inflow, Sum Outflow, and Transparency options are not available. 

In both brain and scalp visualization modes, zooming is done interactively. 

The 3D image can be rotated by left-dragging the mouse. The displayed brain or head can be moved / 
zoomed by left-dragging the mouse while holding down the Ctrl / Ctrl+Shift key. 

The mouse cursor symbol signals the available interaction associated with clicking and/or dragging: 

 Rotate 3D image. 

 Move 3D image. 

 Zoom 3D image. 

 

Circular Graph View 

The Circular Graph View will display connectivity values from the connectivity matrix shown as links 
between sources / sensors. 

The sources/sensor labels are placed according to their position in the anterior or posterior region and 
left or right hemisphere. Connections are represented by colored lines. Connectivity values are 
represented through a colormap, which you can see in the colorbar on the bottom right of the window. 
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By adjusting the Threshold slider, 
the minimum connectivity value that 
will be displayed on the graph can 
be selected.  

For directional connectivity 
methods, one arrowhead will be 
displayed for each link, indicating 
the directionality of the information 
flow. 

When averaging in the time and/or 
frequency is active, the Circular 
Graph View will visualize results for 
the selected time and frequency 
ranges. 

If Show Connectivity Info checkbox is checked, further information for the currently selected pair of 
sources/sensors is shown in the main window. 
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12. Exporting Images, Video, and Results 

12.1. Exporting Images 

For the Set Parameters work step and after completing computation in the Perform Calculations 
work step for all workflows, it is possible to export resulting images in the Main Window and the Detail 
Windows. This can be achieved via the menu bar (see 8.2.4) or via right-clicking in the corresponding 
window. 

  

Images can be saved as portable network 
graphics (*.png), vector graphics (*.eps) or 
scalable vector graphics (*.svg). 

The selection can be made in the saving dialog 
under Save as type: 

 

When saving *.png files, the dimension and 
resolution of the resulting image can be defined. 
By default, the current size of the image on the 
screen is used. Width and height can be altered 
with or without constraining proportions using mm 
or inch as units. The resolution can be set to 150, 
300 or 600 dots per inch. 

When saving *.eps or *.svg file, the image size 
cannot be changed as vector graphics are by 
definition fully resizable. 

 

 

Capture Images 

The main, left detail, and right detail windows can be captured to the clipboard using the context menu 
Capture This Window and Capture All Windows (right-clicking in the corresponding window). 

The windows can be also captured to the clipboard using the following shortcut: 
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• Ctrl+C: capture a window under the mouse cursor 

• Ctrl+Shift+C: capture all windows 

12.2. Exporting Video 

Video export can be used to record a temporal evolution of brain connectivity for the selected 
frequency (or frequency range if Average over Frequency is active) in 3D view mode in the 
Connectivity analysis work step.  

After selecting the Video export option, a 
settings dialog will be shown. The video can be 
saved with standard cinematic resolution 
ranging from SD (720 × 480 px) to UHD (3840 × 
2160 px). The desired value can be selected 
from the Resolution dropdown menu. 

A start and end time can be set using Start 
Time [ms] and End Time [ms] sliders. These 
values can be adjusted by manual editing, by 
setting the slider position or by pressing left and 
right arrows to increase or decrease the 
selected value, respectively. The time step of 
this settings is the same as the time sampling of 
the selected time-frequency method. 

The setting Duration Per Latency Step [s] can 
be used to decide how long one latency position 
will be shown in the video. This directly 
influences the video length which depends also 
on the temporal resolution, and on starting and 
ending time (number of temporal samples). The 
final video length is automatically computed and 
returned in the  Video Length [s] field. 

The Rotation [deg] value can be adjusted to 
decide if the 3D rendered object (brain surface 
or scalp) should be rotated during the video. To 
disable rotation, use 0 degree as rotation value. 
A default value of 360 degree generates a full 

turnaround. A checkbox marked by symbol  
sets the rotation to go forth and back, which 
may be useful if the video should loop around.  

The background color of the video can be 
easily changed by clicking one of three 
rectangles with predefined colors (white, BESA 
sandy, or black). In addition, any color can be 
chosen by clicking of the button with three dots 

. After pressing this button an advanced 
color picker menu will be shown. 

To start video recording press the  button. 
The video generation can be observed in the 
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Main Window1. After video registration is 
finished, the results can be previewed in the 
preview sub-window. To change the latency 
shown in the preview sub-window, use a slider 
in the Recording section.  

After finishing preparation of the video it can be 
saved by pressing the Save button or discarded 
by pressing the Cancel button. If the Save 
button was pressed a file save dialog will be 
shown. The video can be saved as *.mpg file.  

12.3. Exporting Time-Frequency Analysis Results 

After the Time-Frequency analysis is 
completed in the Perform Calculations work 
step, it is possible to export analysis results 
via the menu bar (see 8.2.4) A choice can be 
made between “Single Trial TF Data”, 
“Averaged TF Data” , “Averaged Waveforms” 
and “Project Results”. The result files are 
stored as comma-separated ASCII files. If 
more than one condition was used during 
analysis, the exported condition will be the one 
currently selected in the Interaction Window 
(10.4).  

Single Trial TF Data will output the Time-
Frequency analysis result for each trial which 
was selected in the Set Parameters work step 
(see chapter 10.3) to a *.tfcs file. See chapter 
14.2 for more details on the file format. 

Averaged TF Data will output averaged data 
of time-frequency analysis. The exported data 
will be exactly the same data as the one used 
to create the Main Window display data, i.e., 
correspond to the choices made in the Select 
Display Type selection group for the 
visualization after the Time-Frequency 
analysis has been performed (see chapter 
10.4). Recall that the available display options 
are temporal-spectral evolution (TSE) or 
Absolute (ABS) value, for Amplitude or 
Power. Data will be exported to a *.tfc file – 
see chapter 14.1 for details.  

Averaged Waveforms will output time-
domain averaged data across all trials. Before 
exporting the averaged waveforms for 
individual channels, the waveforms can be 
reviewed in the left Detail Window of the Main 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Due to the OpenGL limitation a flickering may be visible when video is recorded. Please move the 
mouse cursor outside the main window to remove this effect.  
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Window. Data is exported in *.avr format (se 
chapter 14.6). 

Project Results will output averaged data of 
time-frequency analysis for all data sets and 
conditions that are part of the current project. 
The exported data will follow the current 
display type, but will also contain all time-
frequency methods that were selected (see 
chapter 14.1). The results will be arranged in 
sub-folders suitable for import into BESA 
Statistics. The top folder lists the date. The 
next level contains the type of time-frequency 
decomposition. The next level contains the 
condition sub-folders. Each of these sub-folder 
contains the *.tfc file of all data sets for the 
condition, and a file describing the sensor 
configuration. Within the date folder, a text file 
containing the project settings is also stored. 

 

12.4. Exporting Connectivity analysis results 

After the Connectivity analysis is completed in 
the Perform Calculations work step it is 
possible to export analysis result via the menu 
bar (see 8.2.4). If connectivity analysis was 
performed for more than one condition, the 
condition currently selected in the Interaction 
window is exported (see 11.4). 

Connectivity Data will output channel to 
channel (or source to source) connectivity 
matrices as shown in the Main Window. The 
data for the currently selected connectivity 
analysis method and the currently selected 
time-frequency analysis method is exported 
(selection in the Interaction window, see 11.4). 
Data is exported as ASCII file of type *.conn. 
Check chapter 14.8 for more details. 

Project Results will output connectivity 
matrices for all data sets and conditions that 
are part of the current project, for all time-
frequency methods and connectivity methods 
applied. The data export folder hierarchy 
follows the description for the project results 
listed in the section above, with the additional 
level of connectivity measure. 
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13. Appendix 

13.1. The BESA Connectivity Data Folder 

The BESA Connectivity Data Folder is the folder or path where BESA Connectivity stores all project 
data to and reads completed or prepared projects from. This folder should exclusively be used for 
storing BESA Connectivity data. 

When starting BESA Connectivity for the first time (see 2.3.1), a local folder accessible to all users is 
suggested as the default folder. Depending on the operating system, this folder is located as follows: 

• Windows 11: C:\Users\Public\Documents\BESA Connectivity\Projects\ 

• Windows 10: C:\Users\Public\Documents\BESA Connectivity\Projects\ 

In most cases, however, it might be more useful to create a shared folder on a server drive, e.g. 
E:\Server\BESA Connectivity Data that is accessible to all users from anywhere in the local network. 
This is more convenient, since BESA Connectivity uses a network support BESA License Key that 
allows the software to be run from any computer in the local network where BESA Connectivity has 
been installed and configured with the shared BESA Connectivity Data folder. 

Notes: 

• If you have a multi-license installation, make sure that two user do not work on the same 
Group and Project at the same time. Currently, BESA Connectivity does not lock projects 
within the network. 

• If there are several major research studies with different Groups, you might want to create 
separate folders to store the data of the different studies separately. BESA Connectivity offers 
the choice to switch between different BESA Connectivity Data folders by selecting the menu 
item File → Select Data Folder. 

• When switching between different BESA Connectivity Data Folders, the project data are 
preserved in each folder and are not copied to the new folder. Thus, you may have to compute 
a Group’s Connectivity twice unless you copy the Group’s subfolder to the new BESA 
Connectivity Data Folder using, e.g. File Explorer, and update the Data Folder Information as 
described below. 

13.2. The BESA Connectivity Data Folder Information File 

For faster access on the different projects in the BESA Connectivity Data Folder, an information file 
called Data Folder Info is created in the subfolder BesaInternal within each BESA Connectivity Data 
folder. The Data Folder information stores the Group and Project file names of all projects in the BESA 
Connectivity Data folder. 

After copying or moving Group data folders from a previous to a new BESA Connectivity Data folder 
using, e.g. Windows Explorer, update the Data Folder information by selecting the menu item File → 
Update Data Folder Info. When switching between folders, make sure that the tick mark of the 
update option stays on in the confirmation dialog box (see 9.4.1). 

13.3. List of error and warning messages 

13.3.1. Error messages 

Workflow 
Workstep 

Message Text / Symbol Description 
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BESA 
Connectivity 

Sentinel LDK Protection 
System 
No valid license detected. Please 
attach a BESA license key in 
your local network. Make sure 
that the HASP driver is installed. 
Also ensure that your HASP is 
up-to-date and that you own a 
license for this version of BESA 
Software (contact 
sales@besa.de). (H0007) 

This message shows up when a BESA License 
Key with a valid license is not found or the license 
driver is not correctly installed. 

BESA 
Connectivity 

BESA Connectivity is already 
running. 
A second instance cannot be run 
on this PC. 

When you run BESA Connectivity while BESA 
Connectivity is already running, BESA Connectivity 
displays this error message. 

BESA 
Connectivity 

The internal error MF_211 
occurred. Please contact our 
support portal. 

The error MF_211 means that something 
unexpected happened (e.g., there is not enough 
space available on the disk or you do not have 
permission to write files on the disk) and the 
program noticed that. 
You can request support using our support portal 
(see chapter 1). 

Start Workflow 
Select Project  

Select the BESA Connectivity 
Data Folder 
You don’t have write privileges 
for the selected folder. Please 
select a valid BESA Connectivity 
Data Folder. 

This message appears when you select a folder 
where you do not have permission to write as the 
BESA Connectivity Data Folder. 

Start Workflow 
Select Project  

Your current BESA Data Folder 
does not contain any projects. 

When there are no saved projects, this message 
shows up after clicking the Open Project button. 

Time-Frequency 
Analysis 
Load Data 

The file C:/xxx/xxx.generic does 
not exist! 

This message shows up when the selected 
Generic file (.generic) does not exists. 

Connectivity 
Analysis 
Load Data 

The file C:/xxx/xxx.generic does 
not exist! 

This message shows up when the Generic file 
(.generic) for the selected Time-Frequency project 
does not exists. 

Connectivity 
Analysis 
Load Data 

The time-frequency project you 
have specified as input for this 
project has not been completed. 
Do you wish to finalize the input 
project? 

[Yes] [No] [Cancel] 

This message shows up when selected Time-
Frequency project exists but has currently no 
completed state. 
• Yes: The current workflow is closed; instead, 

the Time-Frequency workflow is resumed. 
• No: The dialog box closes. 
• Cancel: Same as No. 

 
Connectivity 
Analysis 
Load data 

The time-frequency project you 
have specified as input for this 
project does not exist anymore. 
Do you wish to select a new 
input project? 

[Yes] [No] [Cancel] 

This message shows up when selected Time-
Frequency project does not exists anymore. 
• Yes: The dialog box is closed to select another 

time-frequency project. 
• No: The dialog box closes. 
• Cancel: Same as No. 

13.3.2. Warning messages 

Workflow 
Workstep 

Message Text / Symbol Description 

BESA 
Connectivity  

A green check mark shows up next to the finished 
worksteps in the Workflow window. 
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BESA 
Connectivity  

A green check mark shows up next to a button in 
order to indicate that the related process is 
successfully finished. 

BESA 
Connectivity  

A yellow question mark shows up next to a button 
in order to indicate that the related process is not 
successfully finished. 

Start Workflow 
Select Project 

The last BESA Connectivity 
session was not closed properly. 
Do you wish to restore the 
previous session? 

[Yes] [No] 

This message appears when you run BESA 
Connectivity again after abrupt termination during 
running a project. 
• Yes: You can restore the previous project. 
• No: The dialog box closes. 

 
Time-Frequency 
Analysis 

Another program has requested 
to start a time-frequency 
analysis. 
Do you wish to close the current 
project and start time-frequency 
analysis? 

[Yes] [No] 

This dialog box appears when another program 
(e.g. BESA Research) requests a new Time-
Frequency project while a project is opened or 
processed in BESA Connectivity. 
• Yes: A new Time-Frequency project is started. 
• No: The dialog box closes. 

Time-Frequency 
Analysis 
Perform 
Calculations 

The settings for running the time-
frequency analysis are as 
follows: 
Frequency range: 
Wavelet settings: 
Complex Demodulation settings: 

[OK] [Cancel] 

Pressing Run Time-Frequency Analysis opens a 
window with a summary of the Time-Frequency 
Analysis Settings. 
If Complex Demodulation was selected the time-
frequency sampling values are shown. If Wavelet 
computation was selected the name of the selected 
wavelet is indicated and, if applicable, its width and 
number of oscillations. 
• OK: Confirming the summary window with OK 

will start the time-frequency analysis 
• Cancel: If these values need changing, it is 

possible to return to the Set Parameters work 
step by pressing Cancel and the Previous 
button. 

Connectivity 
Analysis 

Another program has requested 
to start a connectivity analysis. 
Do you wish to close the current 
project and start connectivity 
analysis? 

[Yes] [No] 

This dialog box appears when another program 
(e.g. BESA Research) requests a new Connectivity 
project while a project is opened or processed in 
BESA Connectivity. 
• Yes: A new Connectivity project is started. 
• No: The dialog box closes. 

Connectivity 
Analysis 
Perform 
Calculations 

The settings for running the 
connectivity analysis are as 
follows: 
 
Settings for non-parametric 
methods: 
Number of iterations: 
Tolerance: 
Regularization: 

[OK] [Cancel] 

Pressing Run Connectivity Analysis opens a 
window with a summary of the Connectivity 
Analysis Settings. 
All selected methods are listed. If non-parametric 
methods are planned to be computed the related 
settings are also displayed. 
• OK: Confirming the summary window with OK 

will start the connectivity analysis. 
• Cancel: If any of the values need to be 

changed, it is possible to return to the Set 
Parameters work step by pressing Cancel and 
the Previous button. 

 

13.4. Range, accuracy and precision of displayed values 

The following table lists measured quantities that are displayed to the user during certain work steps in 
clinical usage of BESA Connectivity. The range, accuracy and precision are also listed. 
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Workflow 
Workstep Measured quantity Range Accuracy Precision 

Time-frequency 
analysis 
Perform 
Calculations 

Mean amplitude over all 
trials at specific time 

Range in µV or fT 
(surface channels) or 
nAm (source 
channels) covers 
physiological range:  
[-100000 … 100000] 

±0.1 µV / fT / nAm ±0.1 µV / fT / nAm  

Time-frequency 
analysis 
Perform 
Calculations 

Absolute amplitude at 
specific time and 
frequency 

[0 … 100000] ±0.1 µV / fT / nAm ±0.1 µV / fT / nAm  

Connectivity 
Analysis 
Perform 
Calculations 

Coherence value at 
specific time and 
frequency 

[0 … 1] ±0.1 ±0.02 
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14. File Formats 
All BESA Connectivity output data formats are in ASCII format to facilitate human readability. All 
floating-point numbers are represented in scientific notation with up to eight significant digits. All 
complex numbers are represented in scientific notation as well, following the scheme: a + ib, where a 
and b are real number and i is a solution of the equation x2 = -1.  

BESA Connectivity uses the BESA generic file format v1.1 (see chapter 14.3 for more details) which 
can be directly exported to BESA Connectivity from BESA Research version 7.0 and higher. The 
generic file can easily be created manually if any other MEG/EEG analysis software is intended to be 
used with BESA Connectivity. 

14.1. The BESA Time-Frequency File Format (*.tfc) 

The header line contains the following data descriptors (14 descriptors displayed in bold, the values 
shown are only examples and comments are in italic): 

1. VersionNumber=__v_5.1: Version number of the current tfc file format. 

2. DataType= TIME_FREQUENCY_AMP: Data type contained in the file. It reflects the options 
selected in the Select Display Type selection group (see chapter 10.4) for the visualization of 
the result once the Time-Frequency analysis has been performed: 

• TIME_FREQUENCY_TSE_AMP: temporal-spectral evolution combined with 
amplitude. 

• TIME_FREQUENCY_TSE_POW: temporal-spectral evolution combined with power. 

• TIME_FREQUENCY_ABS_AMP: absolute value combined with amplitude. 

• TIME_FREQUENCY_ABS_POW: absolute value combined with power. 

3. ConditionName=s: Condition name.  Usually indicated by experiment. E.g. "high-" or " low 
intensity". 

4. NumberTrials=250: Number of trials. 

5. NumberTimeSamples=25: Number of time samples. 

6. TimeStartInMS=-100.0: Start time in [ms]. 

7. IntervalInMS=25.0: Interval length in [ms]. 

8. NumberFrequencies=24: Number of frequency bins. 

9. FreqStartInHz=4.0: Starting  frequency in [Hz]. 

10. FreqIntervalInHz=2.0: Frequency interval in [Hz] (only relevant for complex demodulation). 

11. NumberChannels=127: Number of channels in the data set. 

12. StatisticsCorrection=Off: Statistics correction flag. Currently always Off. 

13. EvokedSignalSubtraction=Off: Flag to signal evoked signal subtraction (On if evoked signal 
is subtracted, Off otherwise). Currently always Off. 

14. Frequencies=4.00;4.47;4.98;…: The frequencies used (only used for wavelets and 
multitapers). 
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The second row of the header contains the labels of the channels. Their labeling can be chosen freely 
provided only letters and number are used and the amount of characters per entry does not exceed 
eight (e.g. E1 E2 ... for electrodes). 

The remaining lines contain NumberChannels blocks starting from the first channel. Each block is 
separated from the next one by an empty line. Each block contains NumberFrequencies-rows and 
NumberTimeSamples-columns. The values for each time-frequency entry in the blocks are floating 
point numbers and should be separated by a tab. 

14.2. The BESA Single Trial Time-Frequency File Format (*.tfcs) 

The file is created without a header. 

The start of each trial export is indicated by the text “Trial” followed by the trial number. The Trial 
statement also separates trials in the exported file. Every time-frequency matrix (block) is preceded by 
the channel number, and the Channel statement separates blocks. The time-frequency data points are 
reported as complex numbers. Each block is organized in a table where columns represent time points 
(increasing from left to right) and rows represent frequencies (increasing from bottom to top). Columns 
are separated by tabulators.  

14.3. The BESA Generic File Format v1.1 (*.generic) 

The BESA generic dataset consists of: 

• The header file (*.generic) 
• The electrode/source definition file(*.elp for electrodes– see 14.4 or *.bsa for sources – see 

14.5)  
• Data file (*.dat – see 14.6) 

The first line must consist of the text: “BESA Generic Data v1.1” (without the inverted commas). 
Previous versions are not supported.  

Subsequent lines must contain the following parameters, in any order (note that the parameters are 
case insensitive). They contain the following data descriptors (descriptors displayed in bold, the 
values shown are only examples and comments are in italic): 

nChannels = 11 The number of channels 

sRate = 125.000 The sampling rate (samples/sec) 

nSamples = 141918 The total number of time samples in the data.  

format = float Currently only float is supported. 

file = binarydata.dat The data file name, without path information. See 14.6 for more 
information 

prestimulus = 400.000 Prestimulus interval in milliseconds 

epochs = 218                     This specifies the number of equally sized epochs in the data.  

baselineStart = -350.000 Start of baseline relative to the trigger onset for each epoch in 
original dataset. The value should be given in milliseconds. 

baselineEnd = 0.000 End of baseline relative to the trigger onset for each epoch in the 
original dataset. The value should be given in milliseconds. 
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epochLength = 1200.000 Length of epoch. Each epoch is indicated by the trigger position 
in the original dataset. The value should be given in milliseconds. 

Padding = 2000.000 Information concerning extra data values that surround the epoch 
to provide padding for wavelets, expressed in milliseconds. If 
exported from BESA Research, the default value is 2000 ms.  

ConditionName = name Name of condition  

channelUnits= Cz µV  A pair consisting of Channel/Source name and unit that was used 
for this Channel/Source (Volts for channels, Amperemeters for 
sources, with appropriate scaling indicator: e.g. µV). The pair is 
separated by a space. The number of channeUnits entries has to 
be equal to nChannels 

14.4. The BESA Channel Definition File Format (*.elp)  

Each line of the channel definition file contains a label, an identifier, and 2D coordinates in angles. The 
format is: Identifier Label Theta-coordinate Phi-coordinate. 

Identifiers can be: 

• EEG - scalp electrode (use also instead of SCP). 

• POL - polygraphic channel (use also instead of PGR). 

• ICR - intracranial electrode. 

• MEG - MEG sensor. 

• REF - reference electrode. This can only occur once. 

Labels should have at most 8 characters and be constituted only by letters and numbers, but can 
otherwise be chosen freely. Note though that the corresponding *.generic files (see 14.3) have to use 
the same convention for the label naming. 

Coordinates are represented as floating point numbers in [deg] in the Head coordinate system. This 
coordinate system is defined by reference points on the head known as fiducials. The reference points 
are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point (RPA). 
The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is defined by 
the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis is 
perpendicular to the x and y axes and goes up out of the upper part of the head (e.g. Cz). The Theta-
coordinate (azimuth) is zero at the z axis, 90 deg at the x axis and -90 deg at the negative x axis. The 
Phi-coordinate instead goes from [-90 deg, 90 deg] from the negative y axis to the positive y axis for 
positive theta (i.e. for the right-hand side of the scalp), while it goes from [90 deg, -90 deg] from the 
negative y axis to the positive y axis for negative theta (i.e. for the left hand side of the scalp). 

14.5. The BESA Solution File Format (*.bsa)  

The file contains the position and orientation of dipoles/sources.  

The first line of the file contains a version identifier BSA_1.04.19990715. 

The second line of the file if the header, identifying the content of each column: 

• Type: defines the type of the respective source. Type can assume the values with the 
corresponding visualization in the 3D window: 
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SngDip single dipole source  

 

RegSrc regional source 

 

RegSrcOri oriented regional source 

 

RegSrcBFVS virtual Beamformer 
regional source 

 

Ring ring object 

 

• x-loc, y-loc, z-loc: the position of the dipole/source in unit sphere Cartesian coordinates. 

• x-ori, y-ori, z-ori: the unit vector orientation of the dipole/source. 

• color: defines the color of the respective object in the 3D visualization. The RGB values 
(ranging from 0 to 255) can be retrieved with the following calculation:  

Red = color % 256  

Green = (color / 256) % 256 

Blue = (color / 65536) % 256 

The reverse operation to get the color (code) from RGB values can be formulated as: 

color = Red * 256 * 256 + Green * 256 + Blue; 

• state 

• size: size of visualized 3D object (default value: 4.50). 

This coordinate system is defined by a sphere with unit dimensions, which is fitted to the coordinates 
of sensors on the head. In the absence of co-registration information with individual MRI data, the 
axes are defined by reference points on the head known as fiducials. The reference points are 
normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point (RPA). 
The direction of the x axis is defined by the line joining LPA and RPA, positive towards RPA. The 
direction of the y axis is defined by the line through NAS that is perpendicular to the x axis (positive 
towards NAS). The z axis is perpendicular to the x and y axes, and goes up out of the upper part of 
the head (e.g. Cz). On average, the center of the unit sphere is about 4 cm above the origin of the 
Head coordinate system.  

14.6. The BESA Binary Data Format (*.dat) 

File containing data associated with generic dataset. Data is written to a floating point binary matrix 
with the extension ".dat". The matrix has the dimension: number of samples × number of channels. 
The information about number of samples and number of channels is retrieved from the header file 
(see 14.3). The epochs are written continuously one after the other including the padding interval.  
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14.7. The BESA ERP / ERF ASCII Vectorized File Format (*.avr)  

The first of two header lines contains the following data descriptors (7 descriptors, the values shown 
are only examples): 

1. Npts= 200: number of sampled points in each channel. 

2. TSB= -500: time sweep begin [ms]. Time of first data point relative to zero of epoch. 

3. DI= 5: digitization or sampling interval [ms]. 

4. SB= 1: default scaling bins/nAm in file. 

5. SC= 200: default scaling calibration. 

6. Nchan= 27: number of channels. 

7. SegmentName= 60dB : an optional label describing the data. 

The second line of the header contains the labels for each channel separated by a blank space. 

Each of the subsequent Nchan lines of the file contains floating point values for all Npts time points.  

14.8. The BESA Connectivity File Format (*.conn)  

The file contains connectivity data. The header line contains the following data descriptors (descriptors 
displayed in bold, the values shown are only examples and comments are in italic): 

VersionNumber = 1.0 Version of file format standard 

DataType = Coherence Connectivity analysis method 

DecompositionType = Complex Demodulation 
Decomposition type used during time-frequency analysis 

ConditionName = Cond1 The name of the condition 

NumberTrials = 218 The number of trials used during analysis 

NumberTimeSamples = 25 The number of time samples 

TimeStartInMS = -350.0000 The starting time position – the first available time point in 
milliseconds 

IntervalInMS = 50.0000 The time interval expressed in milliseconds 

NumberFrequencies = 59 The number of frequencies 

FreqStartInHz = 2.0000 The starting frequency – the first available frequency in Hertz 

FreqIntervalInHz = 1.0000 The frequency interval expressed in Hertz (only relevant for 
complex demodulation) 

Frequencies=4.00;4.47;4.98;…: The frequencies used (only used for wavelets and 
multitapers) 

NumberChannels = 11 The number of channels 
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The second row of the header contains the labels of the channels / sources. 

The remaining lines contain connectivity data. Data is divided into blocks (2D tables). The number of 
tables is equal to NumberChannels to the power of 2 since every channel is compared with all other 
channels (including itself, but here all connectivity values are equal to 1). Each block is separated from 
the next one by an empty line. Each block contains NumberFrequencies-rows and 
NumberTimeSamples-columns. The values for each time-frequency entry in the blocks are floating 
point numbers and are separated by a tab. 
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